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Revision History

The following table lists the revisions of this document.

Table 1: Revision History

Revision Change Description

Revision 02 Installing ArubaOS ISO image on vSphere Hypervisor.

Revision 01 Initial release.




About this Guide

This guide describes the steps to install, configure, and deploy the Mobility Master Virtual Appliance or Mobility
Controller Virtual Appliance on:

= vSphere Hypervisor
= Kernel-Based Virtual Machine (KVM) Hypervisor

The steps to deploy a Mobility Master Virtual Appliance and Mobility Controller Virtual Appliance as a standby
controller or managed device are the same.

N

=
o
-
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For information related to licensing, refer to the Aruba Mobility Master Licensing Guide.

=
(=]
-
m

Important

The following sections of the guide have references to configuration changes that need to be made when
installing a Mobility Controller Virtual Appliance:

= ArubaOS VM Requirements
= Assigning Network Connections

Conventions

The following conventions are used throughout this document to emphasize important concepts:

Table 2: Typographical Conventions

Type Style Description

Italics This style is used to emphasize important terms and to mark the titles of books.

System items | This fixed-width font depicts the following:

m  Sample screen output

m  System prompts

m  Filenames, software devices, and specific commands when mentioned in the text

Commands In the command examples, this bold font depicts text that you must type exactly as shown.

<Arguments> In the command examples, italicized text within angle brackets represents items that you
should replace with information appropriate to your specific situation. For example:

# send <text message>

In this example, you would type “send” at the system prompt exactly as shown, followed by
the text of the message you wish to send. Do not type the angle brackets.

[Optional] Command examples enclosed in brackets are optional. Do not type the brackets.
{Item A | In the command examples, items within curled braces and separated by a vertical bar
Item B} represent the available choices. Enter only one choice. Do not type the braces or bars.

The following informational icons are used throughout this guide:
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E Indicates helpful suggestions, pertinent information, and important things to remember.
NOTE

/\ Indicates a risk of damage to your hardware or loss of data.
CAUTION

Indicates a risk of personal injury or death.

WARNING
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Contacting Support

Table 3: Contact Information

Main Site

arubanetworks.com

Support Site

support.arubanetworks.com

Airheads Social Forums and Knowledge
Base

community.arubanetworks.com

North American Telephone

1-800-943-4526 (Toll Free)
1-408-754-1200

International Telephone

arubanetworks.com/support-services/contact-support/

Software Licensing Site

hpe.com/networking/support

End-of-life Information

arubanetworks.com/support-services/end-of-life/

Security Incident Response Team

Site: arubanetworks.com/support-services/security-bulletins/
Email: sirt@arubanetworks.com



http://www.arubanetworks.com/
https://support.arubanetworks.com/
http://community.arubanetworks.com/
http://www.arubanetworks.com/support-services/contact-support/
https://h10145.www1.hpe.com/support/SupportLookUp.aspx
http://www.arubanetworks.com/support-services/end-of-life/
http://www.arubanetworks.com/support-services/security-bulletins/
mailto:sirt@arubanetworks.com
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Chapter 2

Introduction

The Aruba Mobility Master Virtual Appliance and Mobility Controller Virtual Appliance provide a 64-bit
virtualized software-based managed platform on virtual machine (VM) architecture. The Aruba Mobility Master
Virtual Appliance and Mobility Controller Virtual Appliance operate on x86 platforms in a hypervisor
environment and can reside with other virtualized appliances. The Aruba Mobility Master Virtual Appliance and
Mobility Controller Virtual Appliance are centralized management platforms for deployment in a virtualized
network infrastructure. Some of the key security features offered by the Aruba Mobility Master Virtual
Appliance and Mobility Controller Virtual Appliance are:

= Authentication

= Encryption Support

= Security Policy

m  Rogue Detection and Suppression
= Security Firewall

Aruba does not recommend over subscription of processors, memory, and NIC ports on the virtual machine.

Listed below are few advantages of switching to Aruba Mobility Master Virtual Appliance or Mobility Controller
Virtual Appliance environment:

= Reduces the number of devices occupying rack space and the overheads associated with managing and
servicing products from different vendors.

= Multiple services are consolidated on a common platform, thereby reducing the cost and optimizing the
infrastructure by providing consolidated services.

= Additional devices can be deployed remotely, increasing hardware selection option and flexibility.
= By eliminating a single point failure, you can create a reliable and high-performance networking system.

On successfully installing the Aruba Mobility Master Virtual Appliance/Mobility Controller Virtual Appliance,
refer to the ArubaOS 8.1.0.x Getting Started Guide for steps to setup the network.

What's New

This section lists the new features and enhancements released in this version of the installation guide.

Seamless Logon for Mobility Master Virtual Appliance

The Seamless Logon feature enables you to login from the Mobility Master Virtual Appliance to a managed
device without entering a password. The user can remotely login from a centralized location (Mobility Master
Virtual Appliance) to any managed device and execute any show commands.

Important

» Aruba does not recommend over subscription of processors, memory, and NIC ports on the virtual
machine.

m  Aruba recommends using a Intel-based enterprise grade CPU .
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ArubaOS VM Requirements

Listed below are the minimum resources required for the ArubaOS VM to function:

| i If the system is not configured with the minimum requirements it might result is reduced performance and capacity
of the SKU being provisioned.

Table 4: Memory and CPU Allocation - Mobility Master Virtual Appliance

Total vCPU (hyper | Memory

Total Supported

K H rvisor Flash/Disk (GB

S yperviso threaded) (e]=)] ERE(E, Interfaces

MM-VA- ESXi 6 8 8 2 data ports (0/0/0,
50 0/0/1), 1 mgmt port
MM-VA- ESXi 6 8 8 2 data ports (0/0/0,
500 0/0/1), 1 mgmt port
MM-VA- ESXi 8 32 32 2 data ports (0/0/0,
1K 0/0/1), 1 mgmt port
MM-VA- ESXi 10 64 64 2 data ports (0/0/0,
5K 0/0/1), 1 mgmt port
MM-VA- ESXi 16 128 128 2 data ports (0/0/0,
10K 0/0/1), 1 mgmt port
MM-VA- KVM 6 8 8 2 data ports (0/0/0,
50 0/0/1), 1 mgmt port
MM-VA- KVM 6 8 8 2 data ports (0/0/0,
500 0/0/1), 1 mgmt port
MM-VA- KVM 8 32 32 2 data ports (0/0/0,
1K 0/0/1), 1 mgmt port
MM-VA- KVM 10 64 64 2 data ports (0/0/0,
5K 0/0/1), 1 mgmt port
MM-VA- KVM 16 128 128 2 data ports (0/0/0,
10K 0/0/1), 1 mgmt port

Table 5: Memory and CPU Allocation - Mobility Controller Virtual Appliance

Total vCPU (hyper | Memory

Total Supported

SKUs Hypervisor threaded) (GB) Flash/Disk (GB) Interfaces

MC-VA- ESXi 4 6 6 2 data ports (0/0/0,
50 0/0/1), 1 mgmt port
MC-VA- ESXi 5 8 8 2 data ports (0/0/0,
250 0/0/1), 1 mgmt port
MC-VA- ESXi 6 16 16 2 data ports (0/0/0,
1K 0/0/1), 1 mgmt port
MC-VA- ESXi 12 48 48 2 data ports (0/0/0,
4K 0/0/1), 1 mgmt port
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Table 5: Memory and CPU Allocation - Mobility Controller Virtual Appliance

Total vCPU (hyper | Memory

Total Supported

i Disk (GB
ANy threaded) (GB) ALY {e12) Interfaces
MC-VA- KVM 4 6 6 2 data ports (0/0/0,
50 0/0/1), 1 mgmt port
MC-VA- KVM 5 8 8 2 data ports (0/0/0,
250 0/0/1), 1 mgmt port
MC-VA- KVM 6 16 16 2 data ports (0/0/0,
1K 0/0/1), 1 mgmt port
MC-VA- KVM 12 48 48 2 data ports (0/0/0,
4K 0/0/1), 1 mgmt port

The hypervisor host should not be oversubscribed in terms of number of VMs configured on a host as it
adversely impacts the functionality and performance of ArubaOS. In instances where more than one VM is
setup in a hypervisor, then:

m  The number of logical processors reported on the hypervisor should be higher or equal to the sum of vCPUs
allocated to each of the VMs setup in that host.

=  The sum of the memory allocated to each VM should not exceed the overall host memory capacity
reported.

m  Thetotal CPU utilization, memory usage, and network throughput should not exceed 80% of the host
capacity.

m  The MC-VA-4K supports up to 4K APs. However, a new MC-VA-4K license SKU is not required. If you plan to
deploy 4K APs on a single Mobility Controller Virtual Appliance, add 4 MC-VA-1K licenses.
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Chapter 3

nstalling ArubaOS on vSphere Hypervisor

Prerequisites
Ensure that the following prerequisites are addressed before starting the installation:

m vSphere Client/vCenter 5.1 or 5.5 is installed on a Windows machine.

= vSphere Hypervisor 5.1 or 5.5 is installed on the server that hosts the Mobility Master Virtual
Appliance/Mobility Controller Virtual Appliance as a guest.

m  OVF template is obtained from an Aruba representative and accessible from vSphere Client/vCenter.

Logging Into ESXi Host Using vSphere Client

| ! This section describes the configuration of the VM using the vSphere Windows client, if vCenter infrastructure is
available the same can be achieved through the web interface provided by vCenter.

Follow the steps to log in to the vSphere ESXi Host:

Open the vSphere Client.

Enter the IP address or name of the vSphere Hypervisor in the IP address / Name field.
Enter the user name in the User name field.

Enter the password in the Password field.

ik N

Click Login.
The vSphere Client page is displayed.

Creating A VM Network For Management
Follow the steps below to create a VM network for management:

1. Login to the vSphere ESXi Host using vSphere Client. For additional information, see Logging Into ESXi Host
Using vSphere Client.

2. FromthevSphere Client page, click Inventory.
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Figure 1 Inventory Button
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3. Click Configuration tab.

Click Networking from the Hardware menu.
5. Click Add Networking.

The Add Network Wizard is displayed.

Figure 2 Adding A Network

localhost.Jocaldomain VMware ESXi, 5.5.0, 2068190

Getting Started | Summary ' Virtual Machines ' ResourceAllocation | Performance [JeblilsME iy Local Users & Groups | Events ' Permissions

Hardware View: |vSphere Standard Switch
Health Status Networking Refresh Properties...
Processors
Memary Standard Switch: vSwitchd Remave... Properties...
Storage VMkemel Port Physical Adapters
L3 'Management Network gﬁ'm vmnicd 1000 Full 53
Storage Adapters vmk( : 10.16.12.27
Metwork Adapters
Advanced Settings
Power Management

6. Select the Virtual Machine radio button and click Next.
7. Select the vSwitch that has VMkernel port mapped for ESXi management network and click Next.
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Figure 3 Selecting A Network Adapter For Management

Select which vSphere standard switch will handle the network traffic for this connection. You may also create a new
vSphere standard switch using the undaimed network adapters listed below.

" Create a vSphere standard switch
Intel Corporation 82599EB 10-Gigabit SFP+ Network Connection

[~ BB vmnic2 Down Mone
I B8 vmnic3 Daown Mone
Intel Corporation I350 Gigabit Network Connection
[ B8 vmnicl 1000 Full 0.0.0,1-255, 255,255,254

{* Use vSwitch0
Intel Corporation I350 Gigabit Network Connection

" BB wmnico 1000 Full 10,16.12,4-10,16.12.4
Prewiew:
Virbual Machine Port Group — - Phiysical Adapters
WM Network i e ER) vmnico
WMkzrnz! Port
Management Metwork g-u-
vmkd : 10.16.12.27

8. Inthe Port Group Properties section, provide a name for the management network in the Network
Label field and select All (4095) from the VLAN ID (Optional) drop-down list. Click Next.

Figure 4 Selecting Port Group Properties

Port Group Properties

Metwark Label: |1.I'M Metwork_Management

YLAM ID (Optional): MNone (0)] j

Mone (0

Preview:
Virtuz| Machine Port Group Physical Adapters
VM Metwork_Management g BB vmnico
YMk=mel Port
Management Network g

wmk0 : 10.16.12.27

9. Click Finish.

The VM network name is set to VM Network_Management and is used as an example in all configuration procedures.

HNOTE

10.Click the ESXi host IP address.

11.Click the Configuration tab.

12.Click Networking from the Hardware section.
13.Click Properties of the VM Network_Management.
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Figure 5 VM Network Properties_Management
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localhost.localdomain VMware ESXij, 5.5.0, 2068190
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Hardware View: |vSphere Standard Switch
Health Status Networking
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Memary Standard Switch: vSwitchd Remove...
Storage VMkemel Port Physical Adapters
v+ Networking [ Management Network . BB vmnicd 1000 Full G2
Storage Adapters vmk0 : 10.16.12.27
Metwork Adapters virtus| Machine Port Group
Advanced Settings L1 VM Network_Management
Power Management B |1 virtual machine(s) | VLAN ID: All (4095)
Aruba05_SC_52827_Sample

14.Select the VM network that was created for management and click Edit.

Figure 6 Edit Network Properties_Management

Paorts |Netwurk Adapters I

Configuration | Summary |
I vSwitch 120 Ports

_ﬁ Management Met... vMotion and IP ...
E WM Metwork_Man... "u’irtuaIMau:hine...|

Add... Remove |

15.Click the Security tab.

16.Select the Promiscuous Mode check box select Accept from the drop-down list.
17.Select the Forged Transmits check box and select Accept from the drop-down list.

Forged Transmits should be enabled for VRRP to function.

15 | Installing ArubaOS on vSphere Hypervisor
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Figure 7 Selecting VM Network Properties

@ VM Network Properties | P |
I General Security ]Trafﬁc ShaD‘lnc1 NIC Team'lnc|1
- Policy Exceptions -

Promiscuous Mode: I3 ]P.ccept _:__]

MAC Address Changes: ™ ]Accept j_]

Forged Transmits: v lAccept _:_]

OK | Cancel J Help

18.Click OK.

19.Click Close.

Creating VM Networks For Traffic
Follow the steps below to create a VM network for traffic:

1. Repeat steps 1 to 4 of Creating AVM Network For Management.
2. Click Add Networking.
The Add Network Wizard is displayed.

Figure 8 Adding A Network For Traffic

localhost localdomain VMware ESXi, 5.5.0, 2068190

Getting Started ' Summary ' Virtual Machines ' Resource Allocation ' Performance  EebliifiNehlly Local Users & Groups | Events ' Permissions

Hardware Wiew: |vSphere Standard Switch
Health Status Networking Refresh Add Metworking... Properties...

Processors

Memary

Standard Switch: vSwitchd Remove... Properties...

Storage Physi rers
+ Networking = 9. ‘ nicd 1000 Full |52
Storage Adapters
Metwork Adapters
Advanced Settings =] g

Power Management

3. Select the Virtual Machine option and click Next.
Select a vSwitch that will handle the network traffic and click Next.
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Figure 9 Selecting A Network Adapter For Traffic

Virtual Machines - Network Access
Virtual machines reach networks through uplink adapters attached to vSphere standard switches.

G . S

Connection Type

Select which vSphere standard switch will handle the network traffic for this connection. You may also create a new

Network Access wSphere standard switch using the undaimed network adapters listed below,
Connection Settings ~
Summary ' Create a vSphere standard switch Speed Networks
Intel Corporation 82599EB 10-Gigabit SFP+ Network Connection
v EB vmnic2 Down None
[ E@ vmnic3 Down None
Intel Corporation 1350 Gigabit Network Connection E
[~ BB wmnici 1000 Full 0.0.0.1-255.255,255.254
" Use vSwitcho Speed Networks
Intel Corporation 1350 Gigabit Network Connection
[~ BB wmnico 1000 Full 10.16.12.4-10.16.12.4 -
Preview:
Virtua| Machine Port Group Phiysical Adaptars
VM Network g—g—cw ymnic2

Help |

< Back | Next > I

Cancel |

5. Inthe Port Group Properties section, provide a name for Network Label and select All (4095) from the

VLAN ID (Optional) drop-down list. Click Next.
Figure 10 Selecting Port Group Properties

Virtual Machines - Connection Settings
Use network labels to identify migration compatible connections common to two or more hosts.

G I =

Connection Type

Port Group Properties
Metwork Access
Connection Settings Metwork Label: I\"M Metwork_Traffic
Summary

WVLAM ID (Optional):

fione )

=

Mong iol

Preview:

Virtual Machine Port Group
WM Network_Traffic

Physical Adapters
g—B—cm vmnic2

Help |

% Back

| Mext = I

Cancel

6. Click Finish.

g Ensure that the Management VM network and the Traffic VM network is isolated to avoid a network loop.

NOTE

7. Click the ESXi host IP address.

8. Click the Configuration tab.

9. Click Networking from the Hardware section.
10.Click Properties of the vSwitch to edit.

17 | Installing ArubaOS on vSphere Hypervisor
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Figure 11 VM Network Properties_Traffic
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11.Select the VM network that was created for traffic and click Edit

Figure 12 Edit Network Properties_Traffic
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12.Click the Security tab.

13.Select the Promiscuous Mode check box select Accept from the drop-down list.

14.Select the Forged Transmits check box and select Accept from the drop-down list.

ArubaOs 8.1.0.0 Virtual Appliance | Installation Guide
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HOTE

Forged Transmits should be enabled for VRRP to function.

15.Click OK.
16.Click Close.

Create two additional networks for traffic and repeat the steps to enable Promiscuous mode and Forged
transmits.

Forged Transmits should be enabled for VRRP to function.

HOTE

The Mobility Master Virtual Appliance supports three network interfaces and Mobility Controller Virtual Appliance
supports four network interfaces. For more information, see ArubaOS VM Requirements on page 10.

Deploying the OVF Template

Follow the steps below to deploy the Open Virtual Format (OVF) template:

1. Loginto the vSphere ESXi Host using vSphere Client. For additional information, see Logging Into ESXi Host
Using vSphere Client.

2. Click File > Deploy OVF Template.
The Deploy OVF Template Wizard is displayed.

It is recommended to copy the template to the client machine before importing the OVF template.

3. Click Browse and navigate to the location of the OVAfile and click Next.
The OVF Template Details option is highlighted.
4. Click Next.
The Name and Location option is highlighted..
5. Inthe Name field, enter a name for the OVF template and click Next.
The Disk Format option is highlighted.
6. Select Thick Provision Lazy Zeroed option and click Next.
The Network Mapping option is highlighted.
7. Select VM Network_Management from the Destination Networks drop-down list and click Next.
The Ready to Complete option is highlighted.

| Installing ArubaOS on vSphere Hypervisor ArubaOSs 8.1.0.0 Virtual Appliance | Installation Guide



Figure 13 Network Mapping

Network Mapping
What networks should the deployed template use?

Source

OVF Template Details Map the netwarks used in this OVF template to networks in your inventory

Mame and Location

Disk Format Source Netwarks | DestinationNetworks |
Network Mapping VM Metwork IVM Network_Management vI

Ready to C let
Fany o empiEtE VM Network Management

VM Metwork_Traffic
VM Metwork_Trafficl
VM Metwork_Traffic2

Description:

The VM Network network -

Help | < Back | Mext = I Cancel

Review your preferences before clicking Finish.

E Do not select Power on after deployment check box in the Ready to Complete window.

8. Click Finish.
The OVF template is deployed.

| a Since the deployment of the OVF template is time consuming, it is highly recommended that the client is on the same
VLAN as the Mobility Master Virtual Appliance/Mobility Controller Virtual Appliance.

9. Click OK.
10.Click Close.

Pre-Allocating Memory

Follow the steps below to pre-allocate memory in the Mobility Master Virtual Appliance/Mobility Controller
Virtual Appliance:

1. Right-click the VM and select Edit Settings or click Edit virtual machine settings from the Getting
Started tab.

2. Fromthe Resources tab select Memory.

3. Select the Reserve all guest memory (All locked) check box.

4. Click OK.
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Figure 14 Editing Memory Settings
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Repeat the steps to pre-allocate memory for other ArubaOS VMs.

For more information on memory and CPU allocation refer to sizing tables in ArubaOS VM Requirements on

page 10 section.

Assigning Network Connections

By default the management network is assigned to all network adapters. If different networks are not assigned
to different adapters it will result in a network loop.

Follow the steps below to assign different networks to different adapters:

1. Click Edit virtual machine settings.

21| Installing ArubaOS on vSphere Hypervisor
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Figure 15 Virtual Machine Settings
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What is a Virtual Machine?

A virtual machine is a software computer that, like a
physical computer, runs an operating system and
applications. An operating system installed on a virtual
machine is called a guest operating system.

Because every virtual machine is an isolated computing

workstation environments, as testing environments, or to
consolidate server applications.

Virtual machines run on hosts. The same host can run
many virtual machines.

Basic Tasks
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& Edit virtual machine settings

environment, you can use virtual machines as deskiop or
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Virtual Machines
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2. Select Network adapter2 and select VM Network_Traffic from the Network label drop-down list.

Figure 16 Assigning A Network
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3. Repeat the steps and assign:

a. Network adapter3 to VM Network_Traffic1
b. Network adapter4 to VM Network _Traffic2

4. Click OK.

The Mobility Master Virtual Appliance does not support more than three network interfaces, but Mobility Master

Virtual Appliance supports four interfaces.
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Enabling Security Profile Configuration

This is an optional step and should be used only if serial console redirection is required. To enable security
profile configuration you need to Telnet over the network.

Click the ESXi host IP address.

Click the Configuration tab.

In the Software section, click Security Profile.
In the Firewall section, click Properties.

vk W

Select the VM serial port connected over network check box.

Figure 17 Enabling VM Serial Port Connected Over Network
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6. Click OK.

Configuring Serial Console for the VM
Follow the steps below to configure serial console for the VM:

1. Select the virtual machine that was created.
2. Click Edit virtual machine settings.

Figure 18 Edit Virtual Machine Settings
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3. Onthe Hardware tab, click Add.
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4. Select Serial Port and click Next.
5. Select Connect via Network and click Next.

Figure 19 Configuring Serial Console
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6. Select Server (VM Listens for connection) and enter telnet://:6001 in the Port URI field.
Figure 20 Connecting The Serial Via Network
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7. Click Next > Finish > OK.

To enable serial console redirect refer to Configuring the Initial Setup on page 43.
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If there are multiple virtual machines ensure they are connected to the same port.

To access the VM console you must telnet to the IP address of the ESXi host.
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Chapter 4
nstalling ArubaOS on a KVM Hypervisor

Prerequisites
Ensure that the following prerequisites are addressed before starting the installation:

m  Enabling Intel VT virtualization hardware extensions in BIOS.
m Installing CentOS 7.2 on the x86 hardware.

Supported Versions
= QEMU?2.0

The host kernel should be miminum version 4.6 and QEMU verision 2.7.0 for optimum crypto throughput performance
with ArubaOS in the KVM infrastructre. Libvrt should support passing of poll-us configuration option from VM
NOTE xmlspecification to QEMU.

Enabling Intel VT Virtualization Hardware Extensions in the BIOS
Follow the steps below to enable Intel IT virtualization hardware extensions in the BIOS:

1. Power on the machine and access the BIOS Settings.

2. Navigate to the Processor submenu. Processor settings menu may be hidden in Chipset, Advanced CPU
Configuration, or Northbridge.

3. Enable Intel Virtualization Technology.

Installing CentOS 7.2

Follow the steps below to install CentOS 7.2 on your system:

Connect a DVD or bootable USB stick to install CentOS 7.2.

Select Virtualization Host in Software Selection and select all Add-Ons for the installation.

Click Done.

Navigate to the location of the CentOS 7.2 file and select the destination folder.

Click Begin Installation.

Create a new user and a root password for the CentOS 7.2 installation during the installation process.
Reboot the server after the installation is complete.

Login to the newly installed CentOS 7.2 and configure the network and connect the server to the Internet.

© NOo U A WDN =

A connection to the Internet is required to validate the installation and to install other packages.

a) Check for cpu virtualization support by executing the following command:

[root@localhost ~]# cat /proc/cpuinfo | grep -i vmx flags : .....VOX .....
b) Check for KYM mode support in the Kernel. If kvm_intel is not listed, manually load kvm_intel using the
modprobe kvm intel command.

[root@localhost ~]# lsmod | grep -i kvm
kvm intel 162153 O

kvm 525259 1 kvm intel

[root@localhost ~]#
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| | If the Operation not supported error message is displayed, ensure that Intel Virtualization technology is enabled in
the BIOS.

HOTE

Install the following packages:

yum install gemu-kvm-tools.x86_64 gemu-kvm.x86_64 gemu-kvm-common.x86_64
yum install virt-manager.noarch virt-manager-common.noarch

yum install virt-install.noarch

yum groupinstall "GNOME Desktop"

yum install tigervnc-server xorg-x11-fonts-Type1

Follow the steps below to install the ArubaOS Mobility Master Virtual Appliance or a Mobility Controller Virtual
Appliance on a KVYM hypervisor:

1.
2.
3.

Configuring the Virtual Network Computing (VNC) Server.
Creating a new VM and installing ArubaOS.
Deploying the Mobility Master Virtual Appliance/Mobility Controller Virtual Appliance.

Configuring the Virtual Network Computing Server

Follow the steps below to configure the Virtual Network Computing (VNC) server and open up the firewall port
to access the server remotely:

1.

Start the VNC Server and configure a password for your CentOS server by executing the following
command:

[root@localhost ~]# vncserver.You will require a password to access your desktop.
Password:

Verify:

xauth: file /root/.Xauthority does not exist

New 'localhost.localdomain:1l (root)' desktop is localhost.localdomain:1

Creating default startup script /root/.vnc/xstartup

Starting applications specified in /root/.vnc/xstartup

Log file is /root/.vnc/localhost.localdomain:1.log

Open the firewall port on the CentOS server to ensure the CentOS server can be accessed using vncviewer.

[root@localhost ~]# netstat -ntap | grep vnc

tcp 0 0 0.0.0.0:5901 0.0.0.0:* LISTEN 14318/Xvnc

tcp 0 0 0.0.0.0:5902 0.0.0.0:* LISTEN 5242/Xvnc

tcp 0 0 10.16.9.130:5902 10.20.102.206:51576 ESTABLISHED 5242/Xvnc
tcp6 0 0 :::5901 :::* LISTEN 14318/Xvnc

tcp6 0 0 :::5902 :::* LISTEN 5242/Xvnc

[root@localhost ~]#

[root@localhost ~]# firewall-cmd --permanent --zone=public --add-port=5901/tcp
success

[root@localhost ~]# firewall-cmd --reload

success

[root@localhost ~]#

Download the AOS ISO image file from support.arubanetworks.com to your CentOS server. The
following are examples of ISO image files:

ArubaOS MM 8.1.0.0 57113.iso.
ArubaOS VMC 8.1.0.0 57113.iso.

Creating a VM and Installing ArubaOS
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Follow the steps below to access the CentOS server through the VNC and start the virt manager to create the

VM to be used by ArubaOS:

1. Access the terminal and type virt-manager to start the Virtual Machine Manager.

2. Access the Virtual Machine Manager tab.

3. Click on File > New Virtual Machine. The New VM dialog box is displayed.

Figure 21 New Virtual Machine
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4. Select Choose Local Install Media and click Forward.

5. Select Use ISO image and click Browse.

6. Navigate to the location of the iso image and click Choose Volume.

G Ensure that Automatically detect operating system based in install media is not selected.

7. Select OS type as Linux and Version as Redhat Enterprise Linux 7.2 from the drop-down lists and click

Forward.

8. Change the Memory (RAM) to 8192 and CPUs to 6 and click Forward.

For Mobility Controller Virtual Appliance the RAM can be setup as 4096 (4GB) and 3 CPUs. For more
information on memory and CPU allocation refer to sizing tables in the ArubaOS VM Requirements on page 10

section.

9. Select Enable Storage for this VM and change the value in Create a disk image on the computer's

hard drive to 4 GB. Click Forward.
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Figure 22 Enabling Storage on the VM
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The size of this disk needs to be at least 4 GB for Mobility Master Virtual Appliance/Mobility Controller Virtual
Appliance.

10.Provide a name for the VM and select Customize configuration before install. Click Finish.

Figure 23 Beginning the Installation
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11.Select VirtlO Disk 1 and click on Advanced Options and make sure the Disk bus option is VirtlO.
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12.Click Add Hardware and add another storage device of 8 GB size (should be greater than half the size of
RAM configured for the Mobility Master Virtual Appliance/Mobility Controller Virtual Appliance).

13.Select VirtlO from the Bus type drop-down list. Click Finish.
Figure 24 Adding a Second Storage Device
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Creating Bridge Entries

Create bridge entries to map all three network adapters that you will create in the steps below:

E Ensure that you create a fourth bridge entry when configuring Mobility Controller Virtual Appliance.

NOTE

1. Login to CentQOS and create three bridges and map three physical interfaces to these bridges.

[root@localhost ~]# brctl addbr brl
[root@localhost ~]1# brctl addif brl enol
[root@localhost ~]1# ifconfig brl up

[root@localhost ~]# brctl addbr br2
[root@localhost ~]1# brctl addif br2 eno2
[root@localhost ~]1# ifconfig br2 up

[root@localhost ~]# brctl addbr br3
[root@localhost ~]# brctl addif br3 eno3
[root@localhost ~1# ifconfig br3 up

2. To make these bridge entries persistent across reboots, create a file in /etc/sysconfig/network-scripts/
for all bridges.
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[root@localhost ~]#vi /etc/sysconfig/network-scripts/ifcfg-brl
DEVICE=brl

STP=no

TYPE=Bridge

IPV6INIT=yes

IPV6_ AUTOCONF=no

IPV6 DEFROUTE=yes

IPV6 FAILURE FATAL=no

NAME=brl
UUID=a65bed6d-a32a-4dca-bd00-f8acf9a356e5
ONBOOT=yes

IPV6 PRIVACY=no

[root@localhost ~1#

[root@localhost ~]1# cat /etc/sysconfig/network-scripts/ifcfg-br2
DEVICE=br2

STP=no

TYPE=Bridge

IPV6INIT=yes

IPV6 AUTOCONF=no

IPV6 DEFROUTE=yes

IPV6_FAILURE_FATAL=HO

NAME=br2
UUID=19c£f4539-9633-40aa-a4c5-606849b6e3db
ONBOOT=yes

IPV6_PRIVACY=DO

[root@localhost ~]#

[root@localhost ~]# cat /etc/sysconfig/network-scripts/ifcfg-br3
DEVICE=br3

STP=no

TYPE=Bridge

IPV6INIT=yes

IPV6 AUTOCONF=no

IPV6_DEFROUTE=yeS

IPV67FAILURE7FATAL=HO

NAME=br3
UUID=cb9%a8df9-aa37-4346-8993-9e3739%9a9%b0ce
ONBOOT=yes

IPV67PRIVACY=HO

3. Click Network Interface and enter the following values:
= Network Source: Specify shared device name.

= Bridge name: br1

= Device model: virtio
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Figure 25 Creating Bridge Entries
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4. Click Add Hardware to add two more network interfaces.
5. Map bridge interfaces (br2 and br3) to these network interfaces.
6. Click Add Hardware to add serial console.

Enabling Serial Console Over Telnet

Follow the steps below to enable serial console over telnet. This procedure is optional.

Remove the existing Serial 1 device and click Add Hardware.

Select Serial on the left pane.

Select TCP net Console from the Device Type drop-down list.

Add the CentOS Server IP in the Host field and change the port number.
Select the Use Telnet check box and click Finish.

ok N o=

Installing ArubaOS on a KVM Hypervisor |




Figure 26 Enabling Serial Console Over Telnet
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6. Execute the following command to ensure the host firewall permits access to port number for serial

console.

[root@localhost ~]# firewall-cmd --permanent --zone=public --add-port=4560/tcp
success

[root@localhost ~]# firewall-cmd --reload

success

| i Enable serial console redirection from the ArubaOS CLI after ArubaOS boots up by executing the following command

serial console redirection enable.

7. Select VNC server as the Spice Server from the Type drop-down list.

8. Select Copy local keymap from the Kepymap drop-down list and click Apply.

9. Select CPUs and make select the Copy host CPU configuration option.

10.Select the Manually set CPU topology option from the Topology drop down list.

11.Ensure the number of Sockets and Threads is always 1 and the value of Cores is the same as the value of
Current allocation.
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Figure 27 Configuring CPU Values
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12.Click Begin Installation and select Install ArubaOS.

Once the installation is complete the system will be halted after configuring the Mobility Master Virtual

Appliance/Mobility Controller Virtual Appliance.
Figure 28 System Halt
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13.Force reset the VM to boot ArubaOS and access to first boot dialogue.

Important

m Ensure you open the firewall port from CentOS terminal and restart the firewall.
[root@localhost ~]# firewall-cmd —--permanent —--zone=public --add-port=7001/tcp
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success
[root@localhost ~]# firewall-cmd --reload
success

[root@localhost ~]#

Configure Multiple Datapath CPUs

To configure multiple datapath CPU's additional configuration is required both in host and guest. The guest
changes cannot be made using virt-manager and hence you need to use the virsh edit command.

Ensure that the virtual machine is gracefully shut down by using either the Reboot or Shut Down option before
editing the VM xml specification.

NOTE

Figure 29 Graceful Shutdown
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Changes in Host

On the KVM server, load the vhost_net module

[root@localhost ~]# lsmod | grep vhost
[root@localhost ~]# modprobe vhost net
[root@localhost ~]# lsmod | grep vhost

vhost net 18152 O

vhost 33338 1 vhost net
macvtap 22363 1 vhost net
tun 27141 3 vhost net

XML Changes in Guest

Use the virsh edit <name of the VM> command in the KVM server and add the <driver name='vhost'
queues='y'/>" tag, wherey = total number of CPU’s allocated to the VM.

For example, for a VM with six VCPU's and three NIC's of type Virtio, edit the xml and add <driver
name="vhost’' queues='6"> " tag for each NIC interface.

aruba@ubuntu-server-16x:~$ virsh list --all

Id Name State
5 centos6.5 running
- vmm—-500dev shut off

[root@localhost ~]# virsh edit vmm-500dev
Domain vmm-500dev XML configuration edited.

Add <driver name="'vhost' queues='6'/> after “model type="virtio™ in the bridge config to ensure the
values for the number of queues for the vhost and CPUs for the VM are the same.

The following snippet is an example of multi-queue XML specification for a single NIC interface. The same tag
needs to be added for all Mobility Master Virtual Appliance NIC interfaces.

</controller>
<interface type='bridge'>
<mac address='52:54:00:d3:4a:3c"'/>
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<source bridge='brl'/>

<target dev='vnetl0'/>

<model type='virtio'/>

<driver name='vhost' queues='6'/>

<alias name='net0'/>

<address type='pci' domain='0x0000' bus='0x00"' slot='0x03"'
</interface>

<interface type='bridge'>

<mac address='52:54:00:49:7a:c6'/>

<source bridge='br2'/>

<target dev='vnetll'/>

<model type='virtio'/>

<driver name='vhost' queues='6'/>

<alias name='netl'/>

<address type='pci' domain='0x0000' bus='0x00' slot='0x04"
</interface>

<interface type='bridge'>

<mac address='52:54:00:d3:55:7d"'/>

<source bridge='br3'/>

<target dev='vnetl2'/>

<model type='virtio'/>

<driver name='vhost' queues='6'/>

<alias name='net2'/>

<address type='pci' domain='0x0000' bus='0x00' slot='0x05"
</interface>

[root@localhost ~]# virsh edit vmm-500dev

Domain vmm-500dev XML configuration edited.

[root@localhost ~]1# virsh dumpxml vmm-500dev | grep queues
<driver name='vhost' queues='6"'/>

<driver name='vhost' queues='6'/>

<driver name='vhost' queues='6'/>

[root@localhost ~]#

function='0x0"'/>

function='0x0"'/>

function='0x0"'/>

Reboot the VM and once the VM boots up you should see three CPUs as indicated in the example

(ArubaMM) [mynode] #show datapath utilization
Datapath Network Processor Utilization

Fo———— Fo——— Fom—m - Fomm Fom e +
\ Cpu | Cpu utilization during past |
| Type | Id | 1 Sec 4 Secs 64 Secs |
e +——— Fo————— Fom— Fom +
SP | 1 | 0% | 0% | 0% |
FP | 2 0% | 0% | 0% |
FP | 3 | 0% | 0% | 0% |

Datapath CPU Allocation Summary

Slow Path (SP) : 1, Slow Path Gateway (SPGW) : O
Fast Path (FP) : 2, Fast Path Gateway (FPGW) : O
DPI : 0, Crypto (CRYP) : O

(ArubaMM) [mynode] #
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Chapter 5
ing ArubaOS ISO on vSphere Hypervisor

Prerequisites
Ensure that the following prerequisites are addressed before starting the installation:

m vSphere Client/vCenter 5.1 or 5.5 is installed on a Windows machine.

= vSphere Hypervisor 5.1 or 5.5 is installed on the server that hosts the Mobility Master Virtual
Appliance/Mobility Controller Virtual Appliance as a guest.

= |SOfileis obtained from an Aruba representative and accessible from vSphere Client/vCenter.

Logging Into ESXi Host Using vSphere Client

This section describes the configuration of the VM using the vSphere Windows client, if vCenter infrastructure is
available the same can be achieved through the web interface provided by vCenter.

Follow the steps to log in to the vSphere ESXi Host:

Open the vSphere Client.

Enter the IP address or name of the vSphere Hypervisor in the IP address / Name field.
Enter the user name in the User name field.

Enter the password in the Password field.

ik N

Click Login.
The vSphere Client page is displayed.

Creating a New VM

1. Right click the host IP address and select New Virtual Machine.
2. Select Custom > Next.

Figure 30 Create a New VM
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3. Enter a name for the new virtual machine in Name field.
4. Select Storage and click datastore1 as the destination storage. Click Next.
5. Select the Virtual Machine Version 8.
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6. Select the Linux radio button for Guest Operating System.
7. Select Red Hat Enterprise Linux 6 (64-bit) from the Version drop-down menu. Click Next.

Figure 31 Selecting the Guest Operating System
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8. Select the required virtual CPUs from the Number of cores per virtual socket drop-down list. In this
example, six virtual CPUs are used for 500 devices. For more information see, ArubaOS VM Requirements

on page 10
Figure 32 Selecting Virtual CPUs
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The virtual CPU configuration speciied on
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guest OS.

Clck Help for information on the number
of processors supported for various
guest operating systems.

9. Select the required memory. In this example 8 GB RAM is used. Click Next.

10.Select the required NICs for the network connections. In this example, 3 NICs are use as the installation is
on the Mobility Master Virtual Appliance, in case of a Mobility Controller Virtual Appliance 4 NICs should be
used.

11.Ensure that the Connect at Power On check-box is not selected for NIC 2 and NIC 3. This ensures that
only the Management interface comes up on when the OS boots up.
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Figure 33 Creating Network Connections
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12.Select LSI Logic Parallel as the SCSI controller. Click Next.
13.Select the Create a new virtual disk radio button an click Next.
14.Create a 4GB disk space using the Disk field. Click Next.

Figure 34 Create New Disk
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15.Select SCSI (0:0) from the Virtual Device Node drop-down list. Click Next.

Adding a Second Disk Virtual Disk and Serial Port

Follow the steps below to create a second virtual disk and a serial port before the installation.

1. Select Edit the virtual machine settings before check box. Click Continue.
2. Click Add in the Virtual Machine Properties page.
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Figure 35 Creating a Second Virtual Disk

() TestyM8.1_tp - Virtual Machine Properies'

|| Hardware | options | Resources | i
Memory Configuration
™ Show All Devices Add... | REmove
1011GB 8=
Hardware | Summary i Memory Size: ﬂ
a8 Memory (adding) 8192 MB Sl2GEH
@ CcPUs (adding) 6 - Maximum recommended for
Video card (adding)  Video card L
© VMCI device (adding)  Restricted 12368 | o g
& New CD/DVD (addin... Client Device mm"m rrﬁf:n’;';“'fl“dfd for
£l Mew Floppy (adding)  Client Device 8468 W iR BLES
© New SCSI Controller... LSI Logic Parallel e ; ;
W NewNIC(adding) VM Network A o O
B New NIC (adding) VM Network 2 16 GB - i dedd
B New NIC (adding) VM Network 3 u e
& New Hard Disk (add... Virtual Disk e quest 0S: 512 MB.
4GB H
2 GEB
1 GBH
512 MEHa
256 MEH
128 ME
saVEH
TzvEH
15 Me H
BIMEH
arpll

Help Finish Cancel

Select Hard Disk as the device type. Click Next.

Create a 16GB disk space using the Disk field. Click Next.

Select SCSI (0:1) from the Virtual Device Node drop-down list. Click Next.

Click Finish.

Select the virtual machine that was created and click Edit virtual machine settings.
Click the Options tab and click Boot Options.

Select the Force BOOT Setup and Failed Boot Recovery check boxes. Click OK.

O o N kW
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Figure 36 First Boot Options
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Deploying the ISO File
1. Power on the VM. The BIOS setup screen is displayed.

2. Inthe BIOS setup screen select the Boot tab and select CD-ROM Drive as the first bootable option. Press
F10 to save and exit.
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Figure 37 BIOS Setup Screen
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3. Addthe ISO file to the local CD drive to enable the VM to select the I1SO file from the local CD drive and start
the installation.

4. Power off and power on the VM to continue with the configurations. For more information, see Configuring
the Initial Setup on page 43.
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Chapter 6

Post-Installation Procedures

Once the installation is complete, follow these post-installation procedures to complete the deployment.

Configuring the Initial Setup
Follow the steps below to configure initial setup:

1. Click Power on the virtual machine.
2. Entervalues for the following first boot parameters in the console:
m  System name
= Switchrole
m [P typeto terminate IPsec tunnel
m  Master switch IP address or FQDN
m Isthis a VPN concentrator for managed device to reach Master switch
m This device connects to Master switch via VPN concentrator
m Master switch Authentication method
m |Psec Pre-shared Key
s UplinkVlanID
= Uplink port
m  Uplink port mode
»  Native VLANID [1]
= Uplink Vlan IP assignment method
m Uplink Vlan Static IP address
m  Uplink Vlan Static IP netmask
m [P default gateway
m DNSIP address
m [PV6 addressonvlan
m Uplink Vlan Static IPv6 address
m  Uplink Vlan interface IPV6 prefix length
m |Pv6 default gateway
= Country code
m TimeZone
m Timein UTC
m Date
m  Password for admin login
m Re-type password for admin login

The choices you entered in the first boot dialog are displayed.
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Enter a static IP as the management IP in VLAN as part of the Mobility Master Virtual Appliance/Mobility Controller
Virtual Appliance setup. This should be a routable IP in an accessible subnet that the user can use to access the
Mobility Master Virtual Appliance/Mobility Controller Virtual Appliance via CLI (SSH) or Web GUI (HTTP) after

VM setup is complete.

HOTE

Enter <Ctrl P> to make changes to the first boot parameters.

3. Enter Yes to accept the changes. The Mobility Master Virtual Appliance/Mobility Controller Virtual
Appliance reboots and displays the log in prompt.

4. Login with user name as admin and the password set in Step 2.

5. Execute the enable command.

6. Power on the Mobility Master Virtual Appliance/Mobility Controller Virtual Appliance and execute the
following command to enable the serial console.

Serial console redirect requires the vSphere Enterprise Plus license. When you enable serial console redirect, the

vSphere console host window will be blank.
HOTE

(host) #serial console redirect enable

Execute the following command to see the status of the serial console.

(host) #show serial console redirect
Serial Console Redirect : Enabled

Execute the following commands to disable and view the status of the serial console.

(host) #serial console redirect disable
(host) #show serial console redirect
Serial Console Redirect : Disabled

Reboot the Mobility Master Virtual Appliance/Mobility Controller Virtual Appliance to access the serial console after
enabling the serial console redirect.

To access the serial console telnet the IP address of the serial console followed by the serial port configured. For
example: telnet 10.16.12.27 6001.

HNOTE

Management Interface

The Mobility Master Virtual Appliance/Mobility Controller Virtual Appliance is a VM instance and access to the
console is dependent on the deployment environment. If access through the serial port is denied you can
alternatively access the console through the Management Interface. After an IP is assigned, the management
interface can be accessed from anywhere in the network. To implement this change a separate routing table is
assigned with its own default gateway for managing the IP that is introduced. This ensures the management
traffic is routed to the right interface.

The initial implementation of this feature covers IPv4, IPv6, and manual configuration of a static IP for
management interface from the console.

This feature cannot be configured using the WebUI.

HOTE

Execute the following commands to configure an IP on the management interface:

IPv4:

(host) [mynode] #configure terminal
Enter Configuration commands, one per line. End with CNTL/Z
(host) [mynode] (config) #interface mgmt
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(host) [mynode] (config-submode)#ip address 10.16.9.203 255.255.255.0
IPv6:

(host) [mynode] (config) #interface mgmt
(host) [mynode] (config-submode)#ipv6 address 2014::184/64

Execute the following commands to configure a default gateway for the management interface traffic and to
segregate the management traffic from the normal data traffic on datapath ports:

IPv4:
(host) [mynode] (config) #ip default-gateway mgmt 10.16.9.2

IPv6:
(host) [mynode] (config) #ipv6 default-gateway mgmt 2014::1
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Chapter 7

Troubleshooting

ARP Issues

Scenario

ARP issue occurs when Promiscuous Mode is not enabled and all VLANSs are disallowed on vSwitch.

Instructions
Enable Promiscuous Mode and allow all VLANSs on vSwitch.
To enable Promiscuous Mode, perform the following steps:

Log in to vSphere ESXi Host.

Switch to Configuration tab.

Select Networking under Hardware section.

Click Properties for a configured vSwitch.

Click Edit under Ports tab of vSwitch Properties window.
Switch to Security tab in vSwitch Properties window.

No vk wbh =

Select Accept from the Promiscuous Mode drop-down list.

G Enable Promiscuous Mode on all ports attached to the VM.
NOTE

8. Click OK.
To allow all VLANs on vSwitch, perform the following steps:

Log in to the vSphere ESXi Host.

Click the Configuration tab.

Select Networking under Hardware section.

Click Properties for a configured vSwitch.

Select a configured VM network under Ports tab of vSwitch Properties window.
Click Edit under Ports tab of vSwitch Properties window.

Select All (4095) from the drop-down list against VLAN ID (Optional).

Click OK.

© N U A WDN =

Characters Repeating In Remote Console

The user notices unintended keystrokes when typing into a remote console. To resolve this issue, refer to the
following KB article:

http://kb.vmware.com/selfservice/microsites/search.do?language=en_US&cmd=displayKC&externalld=196

Networks Cards Not Detected
When a new network card is added to the ESXi/ESX host the following symptoms might be displayed:

m  The new network card is not recognized by the system.
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m  The new network card is not listed when you run the command esxcfg-nics -I.
To resolve this issue, refer to the following KB article:

http://kb.vmware.com/selfservice/microsites/search.do?language=en_
US&cmd=displayKC&externalld=1034782

HP Proliant DL580 Running ESXi 5.5 Is Not Powered On Due To
Memory Leaks

HP Proliant DL580 running ESXi 5.5 will not be powered on due to memory leaks. To resolve this issue, refer to
the following KB article:

http://kb.vmware.com/selfservice/microsites/search.do?language=en_%20US&cmd=displayKC&externalld=2
085618

Network Interfaces Are Not In The Correct Order

Adding a fifth network adapter that uses vmxnet3 devices changes the PCl bus IDs and also the order of
network interfaces. To resolve this issue, refer to the following KB article:

https://communities.vmware.com/thread/443600

Connectivity Issues Observed When Using Multiple vSwitches

Connectivity issues observed when multiple vSwitches in a VM network. To resolve this issue, refer to the
following KB article:

https://communities.vmware.com/thread/460582
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Chapter 8

Appendix

This chapter details additional information required in the current version of the Mobility Master. Click the
following links for more information:

m Increasing the Flash Size on a vSphere Hypervisor on page 48

m Increasing the Flash Size on a KVM Hypervisor on page 51

m  Backing up and Restoring Critical Data on page 53

m  Datapath Debug Commands on page 56

m Implementing Management Interface on page 55

m  Upgrading a Controller on page 59

Increasing the Flash Size on a vSphere Hypervisor

ArubaOSs enables you to increase the size of your flash to ensure that the flash is hosted on a separate disk. By
doing this you can move to a hard disk with higher storage capacity for flash with minimal impact. Follow the
steps below to increase the size of the flash on the Mobility Master Virtual Appliance.

1. Power down the VM.
2. Right click the VM in the vSphere client and click Edit Settings.
3. Click Add in the Virtual Machine Properties window.

Figure 38 Virtual Machine Properties
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4. Click Hard Disk in the Add Hardware window and click Next.
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Figure 39 Selecting the Device Type
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5. Select Create a new virtual disk and click Next.
6. Enter avalue of the desired disk size and select Thick Provision Lazy Zeroed. Click Next.

Figure 40 Create Disk
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7. Click Next in the Advanced Options window and click Finish.
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Figure 41 New Hard Disk
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8. Power on the VM and ArubaOS will migrate data from the old hard disk to the new one.

Figure 42 Migrating Data
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9. Confirm if the newly added Hard disk 3 is used by ArubaOS. The Hard disk 3 will be listed as /dev/sdc1
and if old hard disk is in use, it will be listed as /dev/sdb1. If the OVF file only contains a single hard disk it

be listed as /dev/sda3.

10.If the new Hard disk 3 is working as expected, the older hard disk can be removed from the VM and

deleted from disk of the vSphere server.
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Figure 43 Removing a Hard Disk
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E ArubaOS supports only 3 disks and the size of the new disk that is added should be more than the current disk size.

Increasing the Flash Size on a KVM Hypervisor

ArubaOSs enables you to increase the size of your flash to ensure that the flash is hosted on a separate disk. By
doing this you can move to a hard disk with higher storage capacity for flash with minimal impact. Follow the
steps below to increase the size of the flash on the Mobility Master Virtual Appliance.

1. To protect the data on the controller, take a flashback up of ArubaOS using scp/ftp/tftp.
(ArubaMM) [mynode] #show storage

Filesystem Size Used Available Use% Mounted on
none 3.0G 5.6M 3.0G 0% /tmp
/dev/vdbl 7.7G 452.7M 6.9G 6% /flash
/dev/vda5 1.4G 380.3M 1022.7M 27% /mnt/diskl
/dev/vda6 1.4G 380.3M  1022.7M 27% /mnt/disk2

(ArubaMM) [mynode] #backup flash

Please wait while we take the flash backup.......

File flashbackup.tar.gz created successfully on flash.

Please copy it out of the controller and delete it when done.

(ArubaMM) [mynode] # copy flash: flashbackup.tar.gz scp: 10.16.9.107 tester
flashbackup.tar.gz

2. Access the virt-manager and right click on the VM. Select Shut Down.
3. Click Shut Down for a graceful shutdown of the VM.
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Figure 44 Graceful Shutdown
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ArubaOS VM Requirements on page 10.
Double click the VM and click Show virtual hardware details. Click on Add Hardware.

Add a new VirtlO Disk according to your requirement. For more information refer to the sizing table in

In the Add New Virtual Hardware window click Storage. Enter a desired value for the Create a disk

image on the computer hard drive option and click Finish. A new disk is added.

Figure 45 Adding New Virtual Hardware
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7. Power onthe VM

. The following message is displayed when ArubaOS boots up.
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HNOTE

Aruba Networks

ArubaOSs Version 8.1.0.0 (build 57204 / label #57204)

Built by p4build®@lemnos on 2017-04-06 at 20:26:23 PST (gcc version 4.7.2)
(c) Copyright 2017 Hewlett Packard Enterprise Development LP.
[10:18:22]:Starting device manager [ OK]

Formatting new flash [ OK ]

Forcing filesystem check on new flash [ OK ]

Mounting new flash [ OK]

Copying files to new flash [ OK ]

8. Once the system boots up, the new disk will show up as vdc and not vdb. The flash will contain the old data.
(ArubaMM) [mynode] #show storage

Filesystem Size Used Available Use% Mounted on
none 3.0G 7.5M 3.0G 0% /tmp
/dev/vdcl 15.6G 477.7M 14.4G 3% /flash
/dev/vda5b 1.4G 380.3M 1022.7M 27% /mnt/diskl
/dev/vda6 1.4G 380.3M 1022.7M 27% /mnt/disk2

(ArubaMM) [mynode] #
9. Power off the VM and select VirtlO Disk2. Click Remove and reboot the controller.
10.Click Yes in the Are you sure you want to remove this device window.

11.The following information is displayed after rebbot and you will be able to use the new disk.
(ArubaMM) [mynode] #show storage

Filesystem Size Used Available Use% Mounted on
none 3.0G 7.6M 3.0G 0% /tmp
/dev/vdbl 15.6G 477.8M 14.4G 3% /flash
/dev/vda5b 1.4G 380.3M  1022.7M 27% /mnt/diskl
/dev/vda6 1.4G 380.3M  1022.7M 27% /mnt/disk2

(ArubaMM) [mynode] #

ArubaOS supports only 3 disks and the size of the new disk that is added should be more than the current disk size.

Backing up and Restoring Critical Data

It is important to frequently back up all critical configuration data and files on the compact flash file system to
an external server or mass storage device. Ensure the following files are backed up regularly:

m Configuration data

»  WMS database

m Local user database

m Licensing database

m  Floor planJPEGs

= Custom captive portal pages
m  X.509 certificates

m  Controller Logs

Back Up and Restore Compact Flash in the WebUI

The WebUI provides the easiest way to back up and restore the entire compact flash file system. The following
steps describe how to back up and restore the compact flash file system using the WebUI on the Mobility
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Master:

1. Click on the Configuration tab.

2. Click Pending Configuration and then Deploy Changes. Pending Changes is visible only when there
changes to be saved, if this option is not visible skip this step.

3. Navigate to the Diagnostics > Technical Support > Backup Flash page.

4. Click Create Backup to back up the contents of the compact flash file system to the flashbackup.tar.gz file.

5. Click Copy Backup to copy the file to an external server.
You can later copy the backup file from the external server to the compact flash file system using the file
utility in the Diagnostics > Technical Support > Copy Files page.

6. To restore the backup file to the compact flash file system, navigate to the Diagnostics > Technical
Support > Restore Flash page. Click Restore.

Back Up and Restore Compact Flash in the CLI

The following steps describe the backup and restore procedure for the entire compact flash file system using
the controller's command line:

1. Enter config mode in the CLI on the controller, and enter the following command:
(host) [mynode] (config) #write memory

2. Usethe backup command to back up the contents of the compact flash file system to the
flashbackup.tar.gz file.

(host) [mynode] (config)# backup flash
Please wait while we tar relevant files from flash...
Please wait while we compress the tar file...
Checking for free space on flash...
Copying file to flash...
File flashbackup.tar.gz created successfully on flash.
3. Use the copy command to transfer the backup flash file to an external server or storage device:

(host) [mynode] (config) copy flash: flashbackup.tar.gz ftp: <ftphost> <ftpusername>
<ftpuserpassword> <remote directory>

(host) [mynode] (config) copy flash: flashbackup.tar.gz usb: partition <partition-number>
You can later transfer the backup flash file from the external server or storage device to the compact flash
file system with the copy command:

(host) [mynode] (config) # copy tftp: <tftphost> <filename> flash: flashbackup.tar.gz
(host) [mynode] (config) # copy usb: partition <partition-number> <filename> flash:
flashbackup.tar.gz

4. Usethe restore command to untar and extract the flashbackup.tar.gz file to the compact flash file system:
(host) [mynode] (config) # restore flash

Back Up and Restore Configuration in the CLI

The following steps describe the backup and restore procedure for the config file system using the controller’s
command line;

1. Enter config mode in the CLI on the controller, and execute the following command:

(host) [mynode] (config) #write memory

2. Use the backup command to back up the contents of the compact flash file system to the
configbackup.tar.gz file.
(host) [mynode] (config) # backup flash
Please wait while we tar relevant files from flash...
Please wait while we compress the tar file...
Checking for free space on flash...
Copying file to flash...
File configbackup.tar.gz created successfully on flash.
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3. Usethe copy command to transfer the backup flash file to an external server or storage device:
(host) [mynode] (config) copy flash: configbackup.tar.gz ftp: <ftphost> <ftpusername>
<ftpuserpassword> <remote directory>
(host) [mynode] (config) copy flash: configbackup.tar.gz usb: partition <partition-number>

You can later transfer the backup flash file from the external server or storage device to the compact flash
file system with the copy command:
(host) # copy tftp: <tftphost> <filename> flash: configbackup.tar.gz
(host) # copy usb: partition <partition-number> <filename> flash: configbackup.tar.gz
4. Usethe restore command to untar and extract the configbackup.tar.gz file to restore the configuration:

(host) [mynode] (config) # restore config

Please wait while we restore the config backup........

Config restored successfully.

Please reload (reboot) the controller for the new config to take effect.

Snapshot

AVMware snapshot is a copy of the virtual machine's disk file (VMDK) at a given point in time. Snapshots
provide a change log for the virtual disk and are used to restore a VM to a particular point in time when a failure
or system error occurs.

A snapshot preserves the state and data of a virtual machine at a specific point in time. A virtual machine
provides several operations for creating and managing snapshots and snapshot chains. These operations let
you create snapshots, revert to any snapshot in the chain, and remove snapshots. For additional information
about snapshots refer to the VMware kb article
https://kb.vmware.com/selfservice/microsites/search.do?language=en_
US&cmd=displayKC&externalld=1015180.

This sections discusses implementation of the management interface on the Mobility Master. It includes the
following:

m Assigning the IP address to the management interface from the CLI

m Ensuring management bound traffic uses the correct interfaces and a default gateway specific to the
management interface

= Protecting the management interface against unwanted traffic and DOS attacks

Once the IP is assigned (manual or dynamic) we should be able to reach the management interface from
anywhere in the network. This requires that we have a default gateway for the management interface. But this
default gateway should not be used for the data routing table of the controller. So the inherent problem is that
we need to have two default gateways; one for the management interface and the other for the data traffic
and the management traffic should be via the management interface only. This is solved by the use of the
iproute2 utility and having a separate routing table with its own default gateway for the management IP. With
this we can ensure that the management traffic does not leak onto unwanted interfaces.

The management interface is mapped to ethO and is a Linux interface. It is not a part of SOS and does not have
access to the SOS firewall to protect itself. Since the management interface is susceptible to attacks it is
imperative that we should firewall this interface. For this we use the iptables firewall present in Linux. We allow
only ssh (22), telnet(2323) ,tftp(69) and HTTPS(443,4343) traffic on the management interface and also rate
limit traffic to protect controller from unwanted traffic flood over the network. Initially phase of this feature is
implemented for manually configuring a static IP for management interface from the console. It covers both
IPv4 and IPv6 implementation. Most of the functional behavior and implementation are same for IPv4 and
IPv6. This feature can be extended for obtaining IP dynamically from DHCP server in the network in future.
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Datapath Debug Commands
Listed below are the commands to view the system statistics of your controller:

m Execute the show datapath frame [counters] command to view statistics of the data traffic processed.
This command displays the frame statistics that are received and transmitted from the datapath of the
controller. Allocated frames indicate buffers allocated at any given point of time. A constant increment in
the buffer indicates a buffer leak.

The following example displays statistics of data traffic processed.

(host) #show datapath frame counters

ot ——— B +
[suM/ | | | |

|[CPU | Addr | Description Value |

t—m— e et et e e e +

| | [00] | Allocated Frames 3155 |

| | [03] | Unknown Unicast 127 |
| | [04] | IPv6 Unknown Unicast 5 |
o ———— o +

| G | [00] | BPDUs Received 28 |
ot ——— B +
m Execute the show port stats command to view the traffic received/transmitted through gigabit ports
using the datapath.
The following example displays the port statistics.
(host) #show port stats
Port Statistics

Port PacketsIn PacketsOut BytesIn BytesOut InputErrorBytes OutputErrorBytes CRCErrors
RxNoMbuf

GE 0/0/0 6179766 46516 1192249262 3446810 0 0 0 0
GE 0/0/1 179 166996 14782 5019706 0 0 0 0
GE 0/0/2 00000000
m Executethe show datapath heartbeat stats command to monitor the health of the systems. Heartbeats

are sent from the control plane to the datapath every second. The packets pass through the datapath CPUs
and return to the control plane in one second. If the load on the system increases or there is a CPU lock
there is a possibility of the heartbeat being missed. If this recurs 30 times consecutively the controller
reboots. The heartbeat probe introduced in this release, sends out a probe when two consecutive
heartbeats are missed and also measures the actual time taken for the packets to pass through the
datapath CPUs and return to the control plane.
The following example displays the heartbeat statistics.
(host) #show datapath heartbeat stats
Sibyte HeartBeat Stats:

Total HB sent: 42686

Total HB send errors: 0

Current HB send errors: 0 (max:30)

HB send errors high water-mark: 0

ArubaOSs 8.1.0.0 Virtual Appliance | Installation Guide Appendix |



Sibyte Probe Stats:
Total probes sent: 0O
Last probe sent @ 0:00:00.000
Last probe rcvd @ 0:00:00.000
m Execute the show datapath dpdk [mempool-stats | ring-stats] command to view the DPDK mempool
and ring statistics. Since the size of the mempool and ring may vary based on the system template this
command identifies the size of the structures used.
The following example displays DPDK mempool and ring statistics.
(host) #show datapath dpdk mempool-stats
DPDK Memory Pool Statistics Table

mPoolName mPoolAddr Flags phyAddr Size hdrSize eltSize tSize priDataSize success bulk
success _objs fail bulk fail objs cPoolCount

log history 0x2aaaaa802080 0 0x0xa%002080 512 64 2048 0 0 0 0 O O 479
mbuf pool 0x2aaa36200000 0 0x0xa9400000 65536 64 4032 0 0 0 0 0 O 62935
msg 0x7fecd6700080 0 0x0x24700080 1024 64 40 24 0 0 0 0 O 1024

(host) #show datapath dpdk ring-stats

DPDK Ring Statistics Table

Flags: Flag - set for single producer or consumer

Used - number of entries in a ring

Freed - number of free entries in a ring

QThreshold - Enqueque Threshold

nQSuccessBulk - Successful enqueues number

nQSuccessObjs - Objects successfully enqueued

nQFailBulk - Failed enqueues number

nQFailObjs - Objects that failed to be enqueued

dQSuccessBulk - Sucessful dequeues number

dQSuccessObjs - Objects successfully dequeued

dQFailBulk - Failed dequeues number

dQFailObjs - Objects that failed to be dequeued

RingName RingAddr Flag Used Freed QThreshold nQSuccessBulk nQSuccessObjs nQFailBulk
nQFailObjs dQSuccessBulk dQSuccessObjs dQFailBulk dQFailObjs

MP log history 0x2aaaaa800000 0 479 544 0 0 0 0 0 0 0 0 O
MP mbuf pool 0x7fecd6600000 0 62908 68163 0 0 0 0 0 0 0 O O
core-0-low Ox2aaaaa%98abc0 2 0 1023 0 0 0 0 0 0 0 0 O
core-0-high 0x2aaaaa98c640 2 0 1023 0 0 0 0 0 0 0 O O
core-l-low Ox2aaaaa%98e6c0 2 0 1023 0 0 0 0 0 0 0 0 O
core-1-high 0x2aaaaa%990740 2 0 1023 0 0 0 0 0 0 0 0 O
core-2-low Ox2aaaaa%9927c0 2 0 1023 0 0 0 0 0 0 0 0 O
core-2-high 0x2aaaaa%994840 2 0 1023 0 0 0 0 0 0 0 0 O

MP msg 0Ox2aaaaa%9968c0 0 1024 1023 0 0 0 0 0 0 0 0 O
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m Execute the show datapath utilization command to view the CPU utilization of all the datapath CPUs
(SP/FP).

The following example displays datapath CPU utilization statistics.

If the CPU speed is more than 2.1 GHz, data displayed under the 64 Secs option is invalid, but valid only for 1 Sec and

T 4 Sec options. Counter inconsistency is only for CPUs with speed more than 2.1 GHz.

(host) #show datapath utilization
Datapath Network Processor Utilization
—————— -1
| Cpu utilization during past |
Cpu | 1 Sec 4 Secs 64 Secs |
0 0
0 0
m Execute the show cpuload [current] command to view the controller's CPU load for application and

system processes. Use the current option to check the output of the top two UNIX commands.

The following example shows that the majority of the controller's CPU resources are not being used by

either the application (user) or system processes.

(host) #show cpuload

user 6.9%, system 7.7%, idle 85.4%

The following example displays the summary of system (CPU) load. When the current option is used, it

displays detailed information of the CPU load for each process.

(host) #show cpuload [current]

top2 - 05:09:29 up 2 days, 9 min, 0 users, load average: 0.00, 0.01, 0.05

Tasks: 132 total, 2 running, 130 sleeping, 0 stopped, 0 zombie

Cpu(s): 2.5%us, 1.5%sy, 0.0%ni, 96.0%id, 0.0%wa, 0.0%hi, 0.0%si, 0.0%st

Mem: 7915932k total, 2817304k used, 5098628k free, 2744k buffers

Swap: Ok total, Ok used, Ok free, 193244k cached

PID USER PR NI VIRT RES SHR S $CPU $MEM TIME+ COMMAND

3462 root 20 0 2134m 1lém 7772 S 26 0.2 744:48.18 sos.shumway.elf

3654 root 20 0 56112 5856 4732 S 4 0.1 40:48.87 gsmmgr

3503 root 20 0 0 0 0 R 2 0.0 63:24.05 kni_single

1 root 20 0 8340 676 572 S 0 0.0 0:00.92 init

2 root 20 0 0 0 0 S 0 0.0 0:00.00 kthreadd

3 root 20 0 0 0 0 S 0 0.0 0:00.22 ksoftirgd/0
5 root 20 00 0 0 S0 0.0 0:02.02 kworker/u:0
6 root RT 0 0 0 0 S0 0.0 0:00.00 migration/0
7 root RT 0 0 0 0 S O 0.0 0:00.00 migration/1
8 root 20 0 0 0 0 S 0 0.0 0:01.94 kworker/1:0
9 root 200 0 0 0 S 0O 0.0 0:07.79 ksoftirqgd/1l
10 root 20 0 0 0 0 S 0 0.0 0:01.26 kworker/0:1
11 root RT 0 0 0 0 S O 0.0 0:00.00 migration/2
12 root 20 0 0 0 0 S 0 0.0 0:01.08 kworker/2:0
13 root 20 0 0 0 0 S 0 0.0 0:05.80 ksoftirgd/2

14 root 0 =20 0 0 0 S 0 0.0 0:00.00 cpuset
15 root 0 -20 0 0 0 S 0 0.0 0:00.00 khelper
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16 root 0 =20 0 0 0 S 0 0.0 0:00.00 netns

Upgrading a Controller

Follow the steps below to upgrade the controller. You can upgrade the OS on the controller either through
WebUI or through the CLI. The following methods can be used to upgrade the OS on the controller;

m TFTP

m FTP

s SCP

m Local File (This option is available while upgrading through WebUI)

Be sure to back up the controllers as described in Backing up and Restoring Critical Data.

In the WebUI:

In the Mobility Master node hierarchy, navigate to Configuration > Upgrade > Software Management.
Choose the upgrade method.

If you are using TFTP, FTP, or SCP for upgrade enter the server IP address.

Enter the image file name.

Choose the partition to upgrade.

Select Yes to Reboot Controller After Upgrade.

Select Yes to Save Current Configuration Before Reboot.

© N LA WDN =

Click Upgrade.
Inthe CLI:
Execute the following commands on the CLI to upgrade the OS:

For TFTP: (host) [mynode] (config)# copy tftp: <TFTP server IP address> <image file name>

system: partition <0 or 1>

For FTP: (host) [mynode] (config)# copy ftp: <FIP server IP address> <username> <image file
name> system: partition <0 or 1>

For SCP: (host) [mynode] (config)# copy scp: <SCP host IP address> <username> <image file name>
system: partition <0 or 1>

Once the image is uploaded in the flash, save the configuration and reload the controller.

If the following error message is displayed, follow the steps above to reload the OS on both partitions.

(host) [mynode] (config)# show image version

Ancillary image stored on flash is not for this release

R e i i I I e I e b b I b I e b b e S e b e b b e e b e b b e b b b b b b b b S b i b i
* WARNING: An additional image upgrade is required to complete the *
* installation of the AP and WebUI files. Please upgrade the boot *

* partition again and reload the controller. *
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